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Contents 

1. PART (30 min.) 

• Demonstrating the importance of software usage in project planning. 

 

2. PART (30 min.) 

• Demonstration of basic project setup in MS Project. Students try their own 
project setup (templates, new project) with MS Project.  

 

3. PART (30 min.) 

• Explaining project settings (calendar, schedule), individual tabs and 
functionalities using a project example 

 

 

 



Learning objectives 

After studying this topic, you should be able to: 

• You will understand the logic of the application and the step-by-step creation 
of the project. 

 

• Perform basic setup of your project in MS Project. 

 

• Phase a project into multiple phases, understand the importance of phasing a 
project and dividing it into multiple parts.  

 

• Work through the basic definition and setup of a project in MS project. 

 

• Understand the importance of software support in project planning. 

 

 



Key readings 

You can find support in the following sources: 

 

• Book – Chatfield and Johnson (2016). MS Project 2016 Step by Step (Part 1, Part 2, Part 3) 

 

• https://www.tutorialspoint.com/ms_project/ms_project_create_new_plan.htm 

 

• https://ppm.express/blog/newbie-guide-how-to-start-using-microsoft-project-in-2023/ 

 

 

MS Project Tutorials – basic setup and calendars: 

• https://www.youtube.com/watch?v=sYy-iFzz1Eo 

• https://www.youtube.com/watch?v=tuCrTKMPu_Y 
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Learning tutorials 

https://www.tutorialspoint.com/ms_project/ms_project_quick_guide.htm 

 

https://support.microsoft.com/en-gb/office/basic-tasks-in-project-8fdbf020-a9e1-45e4-bf15-
23a8d2b6797d 

 

 

https://ppm.express/blog/newbie-guide-how-to-start-using-microsoft-project-in-2023/  
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PART 1 

 

Planning with the computer 

Everything in our life is a project – 

small, medium, or large it’s always 

the same steps, but the different 

scopes of work and efforts. 

 

• When we talk of project management, we 

refer to the application of skills, processes, 

methods, knowledge, and experience to 

achieve your project goals. It ensures that the 

final deliverables are constrained to specific 

reasonable timelines and budgets. 

 

• You need the right instruments or tools to 

successfully manage your PM activity. 

 

• Various programs exist for this purpose, the 

key among them being Microsoft Project. 

 

• A planning program is indispensable if larger 

projects need to be planned on a regular basis. 

Besides planning activities over time, the 

costs of a project are also monitored with MS 

Project software. 

 

 



Microsoft Project  

• The Microsoft Project is a good option if you’re 

looking for a powerful project management tool 

that enables teams to organize and manage their 

projects of all sizes. 

• Project managers using MS Project Desktop 

save their information as mpp files, so they can 

share it with other team members to use it 

separately when the project evolves; or they 

export it to MS Project Online to use it on cloud-

based software. 

• MS Project Online targets multiple users where 

you can assign tasks, track time, and look into 

other related project elements. The desktop 

version targets mainly project managers who get 

to use it in defining and tracking tasks. 

 



What does a project look like in MS Project? 

 



How to create and manage your project schedule 

• After you complete the initial thinking about 

your project’s objectives, it’s time to put together 

a schedule. 

 

• When you start a new schedule, you add tasks 

and organize them efficiently so that the project 

end date occurs as soon as possible. So, the first 

step will be to create a new project (let’s start 

from the beginning). 

 

• You can start by creating a new project from a 

template – many of these templates have been 

created by industry experts to help you get 

started. 



How to create and manage your project schedule 

• The user interface of MS Project is given by tabs, which are designed to be used in relation to 

the different phases of the project lifecycle:  

• the Project tab for setting up the project,  

 

• the Task and Resource tabs for scheduling and tracking, respectively, and  

 

 

 

 
 

• the Report and View tabs are helpers when preparing project status reports or printouts. 

 



How to create and manage your project schedule 

• The File tab then acts as an access point to 

Backstage. In this interface, we work with the 

project file and change the application's 

behavior settings.  

• Specifically, we find here tools for saving the 

file to different formats, print control, means 

for securing with server solutions (SharePoint 

server, Project Server).  

• The options dialog allows you to change the 

generic properties of MS Project. It is possible 

to specify data calculation methods (e.g. 

conditions for critical path calculation or time 

unit conversions), modify data display (date, 

time), or change standard application settings 

(effort-driven function, scheduling mode 

selection), etc. MS Project UI. 



How to create and manage your project schedule 

You can assign the lower part of the 

window to a data entry form in addition to 

a specific view.  

 

To split the window, check the Details box 

on the View tab or on the Task and Source 

tabs in the Properties group, where you 

select Split View.  

 

In the application, you can open multiple 

project files at once, or you can open a 

single project in multiple windows with 

different views. To switch between file 

windows, that is, to select different 

document windows to work with, use the 

Views tab in the Window group. 



Establishing a project MS Project UI  

The screen should have the MS Project 

interface displayed. The major part of this 

interface are: 

• Quick Access Toolbar − A customizable area 

where you can add the frequently used 

commands. 

• Tabs on the Ribbon, Groups −  the ribbon 

having multiple tabs, each holding a toolbar 

bearing buttons and occasionally other 

controls. Toolbar controls have 

heterogeneous sizes and are classified in 

visually distinguishable Groups.  

• Commands − The specific features you use 

to perform actions in Project. Each tab 

contains several commands. If you point at a 

command you will see a description in a 

tooltip. 

• View Label − This appears along the left edge of the active 

view. Project includes lots of views like Gantt Chart view, 

Network Diagram view, Task Usage view, etc.  

• View Shortcuts − This lets you switch between frequently 

used views in Project. 

• Zoom Slider − Simply zooms the active view in or out. 

• Status bar − Displays details like the scheduling mode of 

new tasks (manual or automatic) and details of filter applied 

to the active view. 



Establishing a project MS Project - example 

Project Wedding  

• Files with tasks saved in Interactive Syllabus 

and IS – materials for study – lectures 

 

1.  Open MS Project – Blank Project 

 

 

 

 

 

 

 

2. File – save as – save under Project Wedding 

With type .mpp 

 

 

 



Establishing a project MS Project - example 

Important! 

MS Project has similar functions to MS Ecel – 

you can add/delete/copy  rows and colums  

 

1. We need to set up the project’s general 

settings: 

Go to: 

File – Options – General – Set up Date Format  

 

2. Set up Display settings: 

Go to: 

File – Options – Display – Set up currency 

section for this project and currency  

 

 

 

 

 



Establishing a project MS Project - example 

We need to set up the project’s schedule settings: 

Go to: 

File – Options – Schedule  

- Calendar options for this project 

- Check week “starts on” and “Fiscal year  

Starts in” 

- Set “Default start/end time 

- Set “Hours per day/week and “Days per 

Month” 

- Scheduling options for this project 

- New tasks created – MUST BE AUTO 

SCHEDULED 

If done, OK 

 

 

 

 

 



Establishing a project MS Project - example 

We need to set up the project’s options “SAVE”: 

Go to: 

File – Options – Save  

- Save files in this format: *.mpp 

- Default file location: 

- Auto save every: 5mins or as you wish 

If done, OK 

 

 

 

 

 

 



Establishing a project MS Project - example 

We need to set up the project’s Information 

about project: 

Go to: 

Project – Project information  

- Project can be scheduled from either: 

- Project start date/ 

- Project finish date  

 

- Set Start date or Finish date according to 

choosing previous “Schedule from” 

- Our project is going to start from “Project 

finish date” 

- Our finish date will be on the 28/12/2024 

If done, OK 

 

 

 

 



Establishing a project MS Project - example 

We need to set up the project’s Calendar: 

Go to: 

Project – Change Working Time 

- We can see window with settings of New 

Calendar/Exceptions/Work Weeks 

- Press Create New Calendar 

 

 

- Set your new calendar name: Wedding 

calendar 

- Choose “make a copy of Standard calendar” 

In “For calendar” will automatically appear your 

newly created calendar. 

If done, OK 

 

 

 

 



Establishing a project MS Project - example 

We need to set up the your own working hours: 

Go to: 

We are still in Project – Change Working Time 

- Check if in “For calendar” is your own calendar 

Wedding calendar 

- Press “Work Weeks” 

- Small window will pop up 

- In here you can adjust the working hours for  

each day of the week  

- As you can see the working hours are as we  

set at the beginning in the “Options”. 

- We will set the working hours from 9am to 12pm 

and from 1pm to 3pm from Monday to Friday. 

- Highlight the days and then set days to these 

specific working hours 

- Then do the same for the weekend days and set 

them as nonworking days. 

If done, OK 

 

 



Establishing a project MS Project - example 

We need to set up the your own Exceptions: 

Go to: 

We are still in Project – Change Working Time 

- Press “Exceptions” 

- In here you can add exceptions to your calendar 

- MS project doesn’t know our bank holidays or other days 

we will not work.  

- Write a name for your exception and choose start and end 

date, then press Details. 

- Small window will pop up. 

- Here we can set for the specific day, if it is working or 

nonworking. If working we put working times and we can 

set how often this will occur down in Recurrence pattern 

and Range of recurrence. 

- We will do 5 exceptions: 

- 17. November – nonworking days 

- 24. December, 25. December, and 26. December – 

working days from 9am to 12pm 

- Wedding day – working day from 8am to 11pm 

- You can see the days with exceptions are of different color. 

If done, OK 

 

 



Establishing a project MS Project - example 

We need to set up your own Wedding calendar 

for your project: 

Go to Tab: 

Project – Project Information 

- In Calendar change your calendar from Standard to 

Wedding calendar 

 

If done, OK 

 

 

 

 

 

 



Establishing a project MS Project - example 

• In this step you write down all your tasks of 

your project 

• In column task name you list all your tasks of your 

project one by one 

• If later you find you need to add more, you just 

enter new row and write in new task 

 

 

 

 

 

 

 

 



Establishing a project MS Project - example 

• You can see that in previous slide the 

duration is set to one day. 

• The next step is to change the duration of 

each of your task. 

• You can see in the Gantt chart how the blue 

lines are changing their length according the 

duration. 

• You need to check that the Task mode is auto 

scheduled all the time 

 

 

 

 

 

 

 



Establishing a project MS Project - example 

• Next step is to make connections between 

your tasks 

• There are 3 ways how you can make 

connections 

1. Highlight two tasks you need to connect 

and press “chain icon”. 

You can see that connection formed. 

 

 

 

 

 



Establishing a project MS Project - example 

2. Way is to write in the Predecessors the number 

ID of the previous task 

• ID number of each task is on the very left 

side of the table. 

 

 

 

 

 



Establishing a project MS Project - example 

3. Way is to double click on the task you need to 

connect. 

• New window will appear and on the tab 

Predecessors you click on the Task name and 

choose the task that needs to be connected. 

• Then, OK 

 

 

 



Establishing a project MS Project - example 

Now we need to establish Task dependency between the tasks 

• You double click on the arrow between two tasks 

• Small window will pop up and you choose the type of dependency. The are 

four and in the next slide I will explain them. 

• You can also choose this dependency when you double click on the Task name 

and choose tab Predecessors and in Type choose the right dependency. 

 

 

 

 

 

 



Establishing a project MS Project - example 

Four types of Task dependency between the tasks 

1. Finish to Start (FS) – Task 2 will start after Task 1 is finished 

 

2. Finish to Finish (FF) – Task 1 and Task 2 will finish at the same 

time, they do not necessarily need to have same start time 

 

3. Start to Start (SS) – Task 1 and Task 2 start at the same time, 

they do not need to finish at the same time 

 

4. Start to Finish (SF) – Task 1 will start after Task 2 is finished 
 

 

 



Establishing a project MS Project - example 

Now we can set indentation of tasks. 

• You can first divide your task into stages or 

phases by adding rows right above the section 

you need to divide. 

• It will appear as New task, so you rewrite the 

name 

• Then you put in the block all the tasks that 

belongs under the first section and your press 

following icon 

• You can see that the first task is in bold and 

the rest tasks have moved little to the right. 

 

 

 

 

 



Establishing a project MS Project - example 

This is how it looks like with 

dividing into sections with 

indentation. 

 

 

 

 

 

 



Establishing a project MS Project - example 

You can also create numbering of your tasks. 

• Right click on the Task name column and 

choose Insert column 

• Then choose name WBS 

• The numbering will be created 

 

 

 

 

 

 



Establishing a project MS Project - example 

Another way how to number your tasks is to enter it in front of each task 

• Go to Gantt Chart Format – click Outline number 

• The numbers will be created in front of the name of the task 

 

 

 

 

 



Establishing a project MS Project - example 

You can watch following videos on how to 

set up MS Project: 

 
https://www.youtube.com/watch?v=_uaFyYIwAyU&list=PLzj7TwUeMQ3g_

ABHdUU7RoGJJm-YFr4_Y&index=1 

 

There are 18 parts to this topic. 
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RECAP 

• MS Project allows you to create a new project, use available templates.  

 

• When setting up a project in MS Project, it is necessary to create a basic 

project calendar, define the working time of the project, its start. 

 

• Each work resource can have its own calendar. 

 

• In the calendar it is possible to set non-working hours, holidays and other 

exceptions.  

 

 


